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BizInsight 5.0.35.1

Adding New Users

This document applies to the following ERP system(s):

Sage 100 (ProvideX and SQL)

This guide describes the steps required to install BizInsight and BizContent for additional users
in your organization.

This document presumes that BizInsight is installed and fully functioning for at least one user
within your organization.
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Step 1: Locate Installation Files

In preparation for installation, you need to confirm which version of BizInsight is installed on
current BizInsight users’ workstations so that you are sure to install the same version being run
elsewhere. To do this, open Excel on an existing BizInsight user’s workstation and click on the
About button of the BizInsight Excel ribbon.

Once you have determined the current version, click on the Application Settings button and
copy the path provided for the Configuration Path parameter, open Windows Explorer and
browse to that directory. Look in that directory or in the level above for an Install Files folder or
a folder for the BizInsight version that is currently installed. Where the installation files have
been saved will vary from customer to customer but it is recommended in our documentation
that they be saved near the BizInsight shared directory so there is a high likelihood that you will
locate the necessary installer in this location or nearby.

If you are not able to locate the installer files for the currently installed BizInsight version, down-
load the latest version from the BizNet Software customer portal, (http://b-
iznet.flexnetoperations.com). In general, it is o.k. for BizInsight users to be on different
BizInsight versions but there is always a chance that the latest version requires a configuration
change that will necessitate all users be updated.

http://biznet.flexnetoperations.com/
http://biznet.flexnetoperations.com/
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All files can be found under "Browse My Software and Documentation".

Following are the files you will need to download:

BizInsight 5.0.35.1

BizInsight Tools.zip - this download file contains several tools that you might need to use during
implementation. It can be found with the BizInsight product download file.

BizContent - download all BizContent files to which you are entitled (required)
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Step 2: Assign BizInsight Security to Users

Each BizInsight user’s Windows account name must be added to a .users file in the admin
shared directory in order for that user to perform any BizInsight action. You will use the License
Administration Tool to perform these steps.

To assign BizInsight security to your users, do the following:

1. On the server, double-click any content installer desktop icon. If the content installers
were installed without desktop icons, browse to the installation directory and double-
click the file named "BizNet Content Installer.exe". If the content installer was
uninstalled, reinstall it.

If you do not want to reinstall the content installer, see "Manual Steps" on page 9.
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2. Click on the Admin Tool button.

3. Click on the ellipses and browse to the admin share folder of your BizInsight shared
directory.
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4. Select your BizInsight license file and click Open.

5. Click on the Validate License button to check how many licenses you currently have.
Your current license count will be displayed.
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6. Click on the Configure Users button. The Current Users dialog will open.

7. You will now add your new BizInsight user and assign them a user type. Click on the User
Type drop down and select the desired user type. If you want your user to be a
Designer, choose Designer from the drop down list.
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8. Type the user's name in the Users field in the format of domain\username.

 WARNING  Do not add your own login using the Admin Tool unless you know for sure
that you have another login available with sysadmin rights to the SQL Server instance.
Early versions of the content installer (pre version 1.6) will remove existing permissions
for users, including those with sysadmin rights. If uncertain, skip this step and confirm
sysadmin access will not be lost then return to complete the Admin Tool step.

9. Click on the Commit Changes button when finished. You will be presented with a
message asking if you want to grant the user additional security permissions. Click Yes.

If you have entered more names for a particular user type than you have licenses, you
will get an error similar to the following.
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You will be returned to the Current Users dialog where you can remove a row so that
you comply with the number of licenses your company purchased. Select the row to
remove and click the Delete Row button.

To purchase additional licenses, use the BizNet Assistant button to open a support ticket
indicating that you need to purchase additional licenses.

When you receive your new license, move your old license from the Administration Path
shared directory and save the new license there. Do not rename the old license and
leave it in the Administration Path; it must be removed from the directory in order for
the new license count to take effect.
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Manual Steps

1. In the Admin shared directory, open the .users file with Notepad that corresponds with
the BizInsight permissions the user should have. For example, if the user should have
Designer permissions, you would open the Designer.users file.

Tip  If you are not sure where to find the Admin shared directory, go to an existing
user’s workstation, open Excel and click on the Application Settings button on the
BizInsight ribbon and copy the path provided for the Administration Path.

2. In the .users file, add the Windows account name of the BizInsight user. For more
information on the different user types, refer to the User Types section of the User
Guide.

3. Save and close the file.

 IMPORTANT  As you add Windows account names to the .users files, add only as many
as you have licenses. If you add more Windows account names than you have licenses or
you have an extra line return in the file, users will get an error message similar to the
following when they open Excel after BizInsight is installed.

If you are not sure how many licenses you have, open the .lic file that is in the Admin
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shared directory with Notepad and check how many licenses are shown for the user type
you are adding.

To purchase additional licenses, use the BizNet Assistant button to open a support ticket
indicating that you need to purchase additional licenses.

When you receive your new license, move your old license from the Administration Path
shared directory and save the new license there. Do not rename the old license and
leave it in the Administration Path; it must be removed from the directory in order for
the new license count to take effect.
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Step 3: Assign rights in SQL Server Security

BizInsight users will need permissions to retrieve data from the accounting system database. If
you did not use the Content Installer Admin tool, users will also need to be given rights to the
SQL MetaData databases.

NOTE  If you are managing SQL Server security with an Active Directory group, just add the new
BizInsight user to that Active Directory group and go to the next step.

1. Click on Start >Programs > Microsoft SQL Server Version > SQL Server Management
Studio.
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2. The Connect to Server dialog will open. Connect to the SQL Server instance that hosts
your accounting system database.

3. In the left pane, expand Security. Look for your existing users to determine whether
they have been setup to use their Windows domain account or a SQL Server account.
You can tell one from the other by the presence of the domain in front of the user
name.

NOTE   If the user's login already exists in SQL Server, right-click their login id and
choose Properties. Then click here to jump to the User Mapping step.
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4. Right-click on Logins and click New Login.

5. In the Login – New dialog box, enter the user’s name in the Login name field. If your
existing users were setup with their Windows logins, click on Search to browse for an
existing Windows login id. If your existing users were setup with a SQL account, type the
new user’s login id and change the radio button to SQL Server authentication.
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6. Click on User Mapping in the left pane. Check the Map checkbox next to the accounting
system database.

7. Once the database is checked in the upper pane, check the db_datareader role
membership in the bottom pane. Click OK.

8. If the accounting system stores company data in separate databases, repeat the steps of
checking the database and the db_datareader role for each company database.
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9. If the SQL MetaData databases (BizInsight and BizInsightDB) are not checked, be sure to
check both of them and give the user db_datareader and db_datawriter rights to those
two databases.
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Step 4: Assign rights in Reporting Services

This step probably has been addressed by the Content Installer Admin tool. In the event an error
occurred while users were being assigned security rights or you did not use the Admin Tool to
assign BizInsight security to the new user, follow these steps to assign them rights to the Report-
ing Services items.

NOTE  If you are managing Reporting Services security with an Active Directory group, make
sure the user is a member of that group and that group has been added to Reporting Services
security.

All BizInsight users must have rights granted to them in Reporting Services. Reporting Services
uses role-based security to secure access to items managed by the report server.

 IMPORTANT  Starting with the BizInsight build , the minimum pre-defined role necessary for a
BizInsight user is Content Manager. A script is provided in the document titled "Installing SQL
Server and Reporting Services" to create a custom role named “” that will assign only the min-
imum permissions required for the XMLFast feature.

Reporting Services Security is accessed by browsing to the Reporting Services Report Manager
URL (ex. http://servername/reports). Go to the Application Settings dialog of your currently
working BizInsight user and copy the Reporting Services URL that is listed in the dialog. Modify
the “reportserver” part of the URL to “reports” then paste into a browser.

 IMPORTANT  If Reporting Services is installed on a Windows Server 2008 or higher server and
User Account Control (“UAC”) is enabled, you must elevate your privileges when you start Inter-
net Explorer. To do this, press CTRL+Shift and then right-click on Reporting Services Con-
figuration Manager and select Run as administrator.

For SQL Server Reporting Services 2005 and 2008, go to the Properties tab:
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For SQL Server Reporting Services 2008 R2, click on the Folder Settings button.

The following screenshot shows an example of a Reporting Service site with user security con-
figured. The user named “linda” has been given Content Manager permissions.
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Step 5: Add User to Column Based Security

If your company has implemented the Column Based Security feature, you will need to specify
the items to which this user will be restricted. The Security Tool for BizInsight is an application
that activates or deactivates column security and configures restriction for user access. When
the column based security mode is activated, all content modules installed on the server are
impacted. See " BizInsight Column Based Security Overview" on page 86 for more information
about Column Based Security.

1. .

2. Double-click the Security Application.exe to launch the Security Tool.
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3. The Security Tool dialog will open.

4. In the Server field, type in the Server name and, if applicable, the instance name for the
SQL Server that hosts the SQL metadata databases (BizInsight and BizInsightDB). The
connection will be made using Windows Authentication by default. Check the SQL
Authentication checkbox to switch to SQL credentials and supply those credentials in
the Username and Password fields. Click Connect.

5. If the Enable Security checkbox is not checked, security is not enabled and you can
close the tool.
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6. Type in the user's Windows login id in the Username field.

If the Apply domain restriction in Username checkbox is checked be sure to provide
the domain name for the Username field.

7. Type in the Values to which the user will be denied access. Separate multiple values
with commas.
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8. When all usernames and values have been entered, click the Commit button. The
application will commit the changes to the ColumnSecurity table. Click OK to the next
two messages and the Dialog will update and display rows for each username/value
combination.

9. Use the Delete Row(s) button to remove any entries that are not wanted. Be sure to
highlight the entire row to be deleted.
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10. Click Exit to close the tool.

For security to be fully implemented, each BizInsight workstation must be configured to use SQL
metadata databases. This is covered in the section titled "Configure BizInsight" later in this
guide.
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Step 6: Install Oracle Data Access Components (ODAC)

If your accounting system is using an Oracle database, you must install the Oracle ODBC driver
and ODP.Net on each client workstation in order for BizInsight to be able to retrieve data from
the Oracle database. If your accounting system does not use an Oracle database, this step can
be skipped.

IMPORTANT

When installing the Oracle Client, it is insufficient to install the Runtime Engine as that does
not install the Oracle ODBC driver.
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Step 7: Install BizInsight

 IMPORTANT  If you are using BizInsight in a Terminal Services/Citrix environment, do not per-
form the following installation steps because BizInsight is already installed on the server.
Instead, log onto the Terminal Services/Citrix server as the new user, browse to the reg5 sub-
directory of the BizInsight installation folder and double-click the file named "Register
BizInsight for Excel xxxx OnDemand.bat". Move to the next step, "Configure BizInsight".

1. Locate the BizInsight product installation files that you downloaded from the portal site
and extract the contents.

2. Extract the .zip contents to any directory that is accessible from the client workstation.

3. Double-click the Setup.exe.

NOTE As of the 5.0.35.2 release, there is a single Setup.exe for all supported Office
versions.

4. The installation will check to see if Microsoft .Net Framework 4.0 is installed.  If not
installed, the following dialog will display.  Click Accept.
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5. The installation will then check to see if the Microsoft Office Primary Interop assemblies
for the installed Excel version are installed as well as a specific Microsoft Update that is
necessary for proper Excel add-in functionality.  If not found, the following dialog will
display.  Click Install.



BizInsight 5.0.35.1 Adding New Users: Step 7: Install BizInsight

BizNet Software, Inc. 27| Page

6. The splash dialog will open.  Click Next to continue.
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7. The Welcome dialog will open.  Click Next to continue.

8. The License Agreement dialog will open.  Read through the agreement and if you agree
with the terms, click the I agree radio button and then click Next.
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9. Accept the default installation directory or browse to a location of your choice. Click
Next.

10. If you are installing a BizInsight version older than 5.0.35.1, the installer will prompt for
some key paths.  Leave the fields blank and click Next. You will enter these values in the
next section.
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11. Click Next at the Confirm Installation dialog.

12. When installing BizInsight versions 5.0.35.1 or higher, the Enter your Configuration
Path dialog will open. If you have an app.config file produced by a Content Installer in
your Configuration Path, leave the default option. Click OK.

If you do not have a Content Installer created app.config file, choose the User Managed
radio button to proceed. You will need to supply the key paths when configuring
BizInsight for the user. When you click OK, the Import Settings Skipped dialog will open.
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Click OK.

13. If the Centrally Managed option was selected, click the Browse button and browse to the
Configuration Path shared directory.

Click Import Settings.
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14. Once the installation completes, click Close.

Installing BizInsight for the Non-Administrative User

If you have installed BizInsight while logged in as a different login than the BizInsight end user,
you will need to perform the following additional steps in order to get BizInsight functioning for
this user.

1. After completing all of the preceding steps to install BizInsight, log out of the client
workstation and log back in as the BizInsight user.

2. Open Windows Explorer and browse to the reg5 subdirectory of the BizInsight local
directory.

3. Double-click the file named "Register BizInsight for Excel xxxx OnDemand.bat", where
“xxxx” is the Excel version (2003, 2007, 2010 or 2013).
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4. If the workstation is running Windows 7 with User Account Control (“UAC”) enabled,
click Yes to all UAC pop-ups.  Click Yes or OK to all dialogs that open.

 IMPORTANT  If you get the following error when running the .bat file, you must edit
the file named “Register BizInsight for Excel xxxx OnDemand.bat” to add the file
directory path to each regedit.exe line.

To edit the "Register BizInsight for Excel xxxx OnDemand.bat", open it with Notepad and
add the file directory path to each regedit.exe entry in the file. For example:
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5. When the .bat file completes, start Excel and continue with the next steps.
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Step 8: Configure BizInsight

1. If you used the Content Installer to create an app.config file to use for Centrally
Managed settings, you can skip this step.
You will need to know the paths for the BizInsight implementation. Go to the server and
start the Content Installer. Click on the Relevant Information link and make a note of the
values shown.

If you cannot find the Content Installer on the server, you can get the necessary
information from an existing BizInsight workstation, if one exists. Open Excel on a
workstation where BizInsight is installed, click on the Application Settings button on the
BizInsight ribbon and copy the values provided for the Configuration Path, the
Administration Path, the Default Reporting Services Server and the Default
Reporting Services Folder Name fields.
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Click on the Configure SQL button to see if the client workstation is configured for SQL
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metadata databases. If this dialog is configured, make a note of the values.

2. While logged in as the BizInsight end user, open Excel.

3. If you receive the following dialog, click Skip.

Click OK to the next message regarding the use of default settings.
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If you receive the following error, go back to the server and grant the user BizInsight
security rights, see "Assign BizInsight Security to Users" on page 92.
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4. The Application Settings dialog will open. If it does not open, click on the Application
Settings button on the BizInsight ribbon.

Perform the following steps:
a. Provide Essential Paths

You must provide values for the Configuration Path, the Administration Path,
the Default Reporting Services Server and the Default Reporting Services
Folder Name fields.
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You should have looked up these values at the start of this section.

b. SQL Credentials Steps (skip if not using SQL credentials for data retrieval from
the Accounting database)

If you configured the Reporting Services data source to use SQL credentials
during content deployment, check the Persist SQL Authentication checkbox.
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c. Click on the Local Content button. If the default path displayed is not a local
directory, click on the Override checkbox and change the path to a directory that
resides on the local computer, C:\BizInsight is suggested.
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d. SQL MetaData Databases and Column Security Steps

If the BizInsight SQL metadata databases (BizInsight and BizInsightDB) were
implemented during the server setup, click on the Configure SQL button. If the
Application Settings dialog does not have this button, BizInsight is not the right
version. You need to uninstall and install the most current BizInsight version.

 IMPORTANT  This step is essential to complete Column Based security
configuration. See " BizInsight Column Based Security Overview" on page 86 for
more information about this optional security feature.

i. Check the Use SQL Server for MetaData checkbox and enter the SQL
Server name, and instance name if applicable, where the BizInsight SQL
databases (BizInsight and BizInsightDB) are located. The format should be
servername\instancename.
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ii. If users will be connecting to the SQL metadata databases using SQL
authentication, check the Use SQL Authentication checkbox. You will get
the following Warning message indicating that the credentials provided
will be stored in clear text in a configuration file in the user’s profile.
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Click OK and enter a valid SQL login and password with appropriate
rights to the SQL MetaData databases. Click OK. 

 IMPORTANT This dialog allows you to use a different method of
connectivity to the BizInsight MetaData databases than for the
accounting system database.

e. Close the Application Settings dialog.

5. Re-start Excel. 

6. Click on the BizInsight tab and then click on the BizInsight Explorer button to load the
Navigation Pane.

7. Skip to the next white background step.

Centrally Managed User Settings (green background)
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8. If you are using Centrally Managed settings, you will see Scan for Content run when you
first open Excel. Click OK and restart Excel.

9. You should see the Navigation Pane display on the left side in Excel.

10. If you receive the following error, go back to your server and make sure all of the
configuration changes have been made for XMLFast (see "CheckTCP/IP, SQL Browser
and Firewall Exceptions" on page 60) and make sure the end user has the db_
datareader and db_datawriter permissions to the SQL metadata databases ( BizInsight
and BizInsightDB).

Click OK to this message as well as the one that follows:
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If you receive the following error, go back to the server and grant the user BizInsight
security rights, see "Assign BizInsight Security to Users" on page 92.

You are now ready to test the installation. Proceed to "Verify the BizInsight Installation".
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Step 9: Verify the BizInsight Installation

Locate an existing BizInsight report to use to verify the installation. Open the report, right-click
anywhere in the report and choose BizNet Refresh.
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Manually Installing BizContent Add-ins

If you are using a BizInsight version that is older than , you will need to register the BizContent
add-ins manually in Excel. BizNet Software recommends upgrading to the latest BizInsight ver-
sion but if that is not possible, perform the following steps:

1. Browse to the BizInsight shared directory and copy the content add-in files (.dll, .xll and
.dna) to the directory to which you installed the BizInsight client.  If you are using
separate config and admin folders, the client add-in files will be in the config folder.

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.



7. Click on Add-ins in the left pane and then click on Go at the bottom on the right
pane.



2. In the Add-ins dialog, click on the Browse button.

3. Browse to the directory to which you installed BizInsight and select the .xll file in
that directory.  Then click OK.

The Add-ins dialog should now look like the following:



4. Click OK.



Excel 2007

1. Click on the Office button and then click on the Excel Options button.



2. Click on Add-ins in the left pane and then click on Go at the bottom on the right
pane.



3. In the Add-ins dialog, click on the Browse button.

4. Browse to the directory to which you installed BizInsight and select the .xll file in
that directory.  Then click OK.

The Add-ins dialog should now look like the following:



5. Click OK.



Excel 2003

1. Click on Tools > Add-Ins



2. In the Add-ins dialog, click on the Browse button.

3. Browse to the directory to which you installed BizInsight and select the .xll file in
that directory.  Then click OK.

The Add-ins dialog should now look like the following:



4. Click OK.



CheckTCP/IP, SQL Browser and Firewall Exceptions

The XMLFast feature added in an earlier BizInsight build requires the following server con-
figuration changes:

l The TCP/IP protocol must be enabled for SQL Server and the SQL Browser Service must be
running. see "Enable TCP/IP" below.

l Server firewall exceptions must be added for TCP Port 1433, UDP Port 1434 and a program
exception for sqlservr.exe. see "Add Windows Firewall Exceptions" on page 70

Customers are strongly encouraged to make these changes in order for the XMLFast feature to
work. While the XMLFast feature can be turned off on the client workstation in Application Set-
tings, doing so will result in significantly slower data retrieval times.

Enable TCP/IP

To enable TCP/IP, the steps vary depending on your SQL Server version.  The steps for SQL
Server 2005 are as follows.  For SQL Server 2008 or higher, see "SQL Server 2008" on page 65.

SQLServer 2005

1. Click on Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools >
SQL Server Surface Area Configuration.



2. Click on Surface Area Configuration for Services and Connections.



3. In the left pane, click on SQL Server Browser. When the right pane has refreshed with
the options for the SQL Server Browser, make sure that Startup Type is set to
"Automatic" and click on Start if the service is not started.



4. Under Database Engine, click on Remote Connections. Select the Local and Remote
Connections radio button to enable remote users to access this SQL Server instance. 
Click Apply.

5. An alert dialog will be displayed indicating that the changes will not take effect until the
Database  Engine service is stopped and restarted.  Click OK.

6. In the left pane, expand Database Engine and click on Service.  In the right pane, click
on Stop and then click on Start when that button becomes enabled.  Once the service is
restarted, click OK to exit the Surface Area Configuration tool.





SQL Server 2008

1. Click on Start > All Programs > Microsoft SQL Server 2008 (2008 R2) > Configuration
Tools > SQL Server Configuration Manager.

2. Expand SQL Server Network Configuration and select the Protocols for InstanceName
that corresponds to the SQL Server instance that hosts the accounting system database.

3. Verify that the TCP/IP Protocol is "Enabled".  If it is not enabled, double-click on the
protocol and change its properties to enabled.  You will receive a warning that the
service will need to be stopped and restarted:



4. Go to the SQL Server Services section.  Select the SQL Server service and click on the
restart the service button.



5. In the SQL Server Services section, verify that the SQL Server Browser service is started. 
If it is not, double-click on the service to open the service properties.



6. Click on the Service tab and make sure the Start Mode is set to "Automatic".



7. On the Log On tab, click on the Start button to start the service



Add Windows Firewall Exceptions

This step may not need to be performed if the Windows Firewall is turned off on the server.

Server 2003 (click here to go to the Server 2008 instructions)

1. Click on Start > Control Panel > Windows Firewall



2. On the Exceptions tab, click the Add Port button.



3. In the Add a Port dialog, enter a name for the exception entry and type "1433" for the
port number.  Click OK.

4. Add a second port exception for UDP 1434.



5. Click the Add Program button then click the Browse button

6. Browse to the SQL Server installation’s Binn directory and select sqlservr.exe.



7. Close the Firewall dialog after making these additions.

Server 2008

1. Click on Start > Administrative Tools > Windows Firewall with Advanced Security



2. Click on Inbound Rules.

3. Click on New Rule.



4. Choose the Port radio button and click Next.



5. Leave the TCP option selected and type in port 1433.  Click Next.



6. Leave the Allow the connection radio button selected and click Next.



7. Uncheck the Public checkbox (unless users are connecting using a public network
location) and click Next.

8. Type a name and description for the exception and click Finish.



9. Repeat these steps to add a UDP port exception for port 1434.



10. Add a third new inbound rule for a program exception.



11. Click on the Browse button and browse to the SQL Server installation’s Binn directory
and select sqlservr.exe.  Then click Next.





12. Leave Allow the connection selected and click Next.



13. Uncheck the Public checkbox (unless users are connecting using a public network) and
click Next.

14. Type a name and description for the exception and click Finish.



BizInsight Column Based Security Overview

Disclaimer:

The following information is for general purposes only. The information is provided by BizNet
Software and while we strive to keep the information up to date and accurate, we make no
representations or warranties of any kind, express or implied, about the accuracy or reliability
with respect to our internal research contained in this documentation. Any reliance you place
on such information is therefore strictly at your own risk.

In no event will BizNet Software, Inc. or BizNet Software, Inc. be liable for any loss or damage
including without limitation, indirect or consequential loss or damage, or any loss or damage
whatsoever arising from loss of data or profits arising out of, or in connection with, the use of
the documentation.

In any ERP system, the balance between making data accessible to end users while denying
access to those who should not have access is a difficult challenge. ERP security only at the
application layer is not a truly secured system; the communication between the application and
the data is exposed to users who are not authorized to access confidential information. BizNet
Software has incorporated four layers of security into the BizInsight product. These security
levels are as follows:

1. BizInsight License User Types Security

2. DataSet Security – applies to RDL security on the Report Server.

3. MetaData Security – applies to SQL Database and Shared Directory folder.

4. Column Security – applies to all functionality on content packs. (Functions, Drill-downs,
and Analysis Sets)

Of the above four security levels, two are specifically provided with the BizInsight product:
BizInsight License User Types Security and Column Security. The other two items, DataSet Secur-
ity and MetaData security, utilize the native security model provided with Reporting Services,
SQL Server,and Windows NTFS security.

BizInsight uses Reporting Services to store the queries and datasets used for connectivity to the
accounting system. Reporting Services provides its own security and BizInsight objects can be



independently secured using the delivered Reporting Services security model. Users must be
granted access to the BizInsight objects published to Reporting Services in order to utilize them.

BizInsight uses SQL databases (BizInsight and BizInsightDB) to store product metadata.
BizInsight users must be provided access to these databases using native SQL Server security. In
addition, the BizInsight shared directory is also a metadata repository and sufficient Windows
NTFS security.

BizInsight License User Types Security

This security level ensures that only licensed users are able to use the BizInsight product. In addi-
tion, BizInsight licensing is broken out into different user types: . The different user types have
decreasing capabilities with the Designer user having the most capabilities. See the User Guide
for more information regarding the different user types and their capabilities.

Column Security

Column security is based on a security policy that specifies the rules and conditions under which
a user can access a column value from a table. The column access restriction is based on indi-
vidual user permissions. When defining the column to apply the restriction, the column must
exist across all datasets from which BizInsight is retrieving data. In most business policies,
restricting access by the “Company" column is the most frequently used security logic; how-
ever, BizInsight provides the flexibility to utilize other columns.

The column security design uses an optimistic method in restricting user access: IT admin-
istrators will need to provide the values to deny. Values not listed are inferred to be allowed.
For example, if a user is permitted to access 97 out of 100 unique values, 3 restricted values
will need to be defined when defining column security for that user. The remaining 97 values
not defined in the security table will be able to be accessed by that user. All possible threats, vul-
nerabilities, and attacks and choosing the security design to implement are based on threat mit-
igation as first and performance second.

When column security is enabled and user restrictions are defined, access to the data will be
restricted for the particular user. On the client machine, the user restriction policy applies to all
content modules and functionality. Any access to functions, drill-down, and analysis set is
denied if the restricted value is inserted in the feature. In the scenario of multiple parameters
being passed to a function, if one of the parameter values is restricted, the security will deny
access completely even though the user many have access to the non-restricted values.



Security vs Performance

Design choices for securing a system affect performance, scalability and usability. The more
secure a system becomes, the more companies must compromise in terms of performance and
usability. In selecting the best balance between security and performance, the optimistic secur-
ity design has proven to be the ideal option. The below research and development results are
based on BizNet Software internal testing and illustrate the impact security has on per-
formance. Results will vary depending on network connection, environmental setup, and
Microsoft Office bitness.

Scenario:

Excel 2010 64-bit
BizData Iterations - 80,688
Dedicated Server and Client Machine

First Refresh
(sec)

Second
Refresh (sec)

Offline
Mode

Number of
Restricted
Values

Baseline: Security OFF on SQL Database 114.57 113.18 69.07 N/A

Security ON with no restricted users 111.4 109.38 75.18 0

Security ON and restricted values apply to
the current user

118.81 114.61 74.16 1

Security ON and restricted values apply to
the current user

124.54 119.9 80.14 6*

Security ON and restricted values apply to
the current user

132.14 126.58 86.39 12*

Security ON and restricted values apply to
other users

114.97 120.16 69.28 N/A

Security ON and restricted values apply to
all users

124.64 119.29 79.16 N/A

* Multiple restricted columns is not currently supported

Key Results:

1. When Security mode is activated with no restricted values in the security table, little to
no significant reporting performance loss.

2. When Security mode is activated with restricted values in the security table, there is
about a 10% loss in reporting performance.



3. When Security mode is activated with double the amount of restricted values in the
security table, there is about a double percentage loss in reporting performance.

Column Security Limitations

l Only a single column can be restricted. Multiple column security is not supported.

l The column must exist across all content packs.

l The column must exist as a server side parameter on RDLs. Security on optional parameters
is not supported.

l The column name should be uniform across all RDLs.

l Connected to an single ERP. Multiple ERP systems are not supported.

l Security is based on an ‘Exclusion Method’. IT administrators must insert values to restrict
access.

Requirements to Use Column Security

l BizInsight 5.0.35.0 and later is installed on all client machines.

l Existing BizInsight and BizInsightDB databases created using a Content Installer and were
created directly in SQL Server (not converted using the Access to SQL conversion tool).

l Reporting Services versions 2005*, 2008, 2008 R2, 2012 or 2014

 IMPORTANT  Reporting Services 2005 requires additional files to be installed. IT admin-
istrators must install the prerequisite files in a particular order. Following is a link to a
Microsoft article with links to the necessary download files.

http://www.microsoft.com/en-us/download/details.aspx?id=16978

http://www.microsoft.com/en-us/download/details.aspx?id=16978


a. Install Microsoft® System CLR Types for SQL Server® 2008 R2

The SQL Server System CLR Types package contains the components implementing
the geometry, geography, and hierarchy id types in SQL Server 2008 R2. This
component can be installed separately from the server to allow client applications
to use these types outside of the server.

b. Install Microsoft® SQL Server® 2008 R2 Shared Management Objects

The SQL Server Management Objects (SMO) is a .NET Framework object model that
enables software developers to create client-side applications to manage and
administer SQL Server objects and services. This object model will work with SQL
Server 2000, SQL Server 2005, SQL Server 2008 and SQL Server 2008 R2.

Column Security User Experience

When a user tries to access data to which they have been denied access, the cell will display
#VALUE.

To confirm that the error is due to Column Security, check the event log by clicking on the
About button on the BizInsight ribbon and then clicking on Support Tools > View Events. A
#COLUMN_SECURITY error will be logged there if the #VALUE is due to restricted access.

If the user refreshes a report that tries to retrieve data for a company to which they have no
access, an error message will be displayed indicating they have requested restricted data:



Analysis sets that try to retrieve restricted data will return #COLUMN_SECURITY:

Refer to the Installation Guide for instructions on implementing Column Based Security.



Assign BizInsight Security to Users

Each BizInsight user’s Windows account name must be added to a .users file in the admin
shared directory in order for that user to perform any BizInsight action. You will use the License
Administration Tool to perform these steps.

To assign BizInsight security to your users, do the following:

1. On the server, double-click any content installer desktop icon. If the content installers
were installed without desktop icons, browse to the installation directory and double-
click the file named "BizNet Content Installer.exe". If the content installer was
uninstalled, reinstall it.

If you do not want to reinstall the content installer, see "Manual Steps" on page 98.



2. Click on the Admin Tool button.

3. Click on the ellipses and browse to the admin share folder of your BizInsight shared
directory.



4. Select your BizInsight license file and click Open.

5. Click on the Validate License button to check how many licenses you currently have.
Your current license count will be displayed.



6. Click on the Configure Users button. The Current Users dialog will open.

7. You will now add your new BizInsight user and assign them a user type. Click on the User
Type drop down and select the desired user type. If you want your user to be a
Designer, choose Designer from the drop down list.



8. Type the user's name in the Users field in the format of domain\username.

 WARNING  Do not add your own login using the Admin Tool unless you know for sure
that you have another login available with sysadmin rights to the SQL Server instance.
Early versions of the content installer (pre version 1.6) will remove existing permissions
for users, including those with sysadmin rights. If uncertain, skip this step and confirm
sysadmin access will not be lost then return to complete the Admin Tool step.

9. Click on the Commit Changes button when finished. You will be presented with a
message asking if you want to grant the user additional security permissions. Click Yes.

If you have entered more names for a particular user type than you have licenses, you
will get an error similar to the following.



You will be returned to the Current Users dialog where you can remove a row so that
you comply with the number of licenses your company purchased. Select the row to
remove and click the Delete Row button.

To purchase additional licenses, use the BizNet Assistant button to open a support ticket
indicating that you need to purchase additional licenses.

When you receive your new license, move your old license from the Administration Path
shared directory and save the new license there. Do not rename the old license and
leave it in the Administration Path; it must be removed from the directory in order for
the new license count to take effect.



Manual Steps

1. In the Admin shared directory, open the .users file with Notepad that corresponds with
the BizInsight permissions the user should have. For example, if the user should have
Designer permissions, you would open the Designer.users file.

Tip  If you are not sure where to find the Admin shared directory, go to an existing
user’s workstation, open Excel and click on the Application Settings button on the
BizInsight ribbon and copy the path provided for the Administration Path.

2. In the .users file, add the Windows account name of the BizInsight user. For more
information on the different user types, refer to the User Types section of the User
Guide.

3. Save and close the file.

 IMPORTANT  As you add Windows account names to the .users files, add only as many
as you have licenses. If you add more Windows account names than you have licenses or
you have an extra line return in the file, users will get an error message similar to the
following when they open Excel after BizInsight is installed.

If you are not sure how many licenses you have, open the .lic file that is in the Admin



shared directory with Notepad and check how many licenses are shown for the user type
you are adding.

To purchase additional licenses, use the BizNet Assistant button to open a support ticket
indicating that you need to purchase additional licenses.

When you receive your new license, move your old license from the Administration Path
shared directory and save the new license there. Do not rename the old license and
leave it in the Administration Path; it must be removed from the directory in order for
the new license count to take effect.
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